CHAPTER 1

Chapter Objectives

INTRODUCTION TO EXCEL 2000

By the time you finish this chapter, you should be able to identify the following terms:

1 Worksheet

J Workbook

U Application window
U Cell

[ Cell cursor

L Active cell

U Home cell

U Title bar

1 Menu bar

U Office Assistant
U] Standard toolbar
U Formatting toolbar
L] Status bar

U Formula bar

0 Name box

U Scroll bar

U Dialog box

By the time you finish this chapter, you should be able to perform the following tasks:

[ Launch Excel 2000

U Create a workbook

U Open a workbook

(1 Navigate the Excel worksheet
() Enter text and numbers

U Use the Zoom setting
O Use help features

U Save a workbook

Q1 Print a worksheet

1 Close a workbook
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INTRODUCTION

In a business, the transfer of information is an ongoing operation. Whether it's letters, memos, or
published documents on the World Wide Web, information is the most valuable asset of any
business. To handle the many different types of information, several types of software are
required. To type our letters and memos, a word processor 18 needed such as Microsoft Word.
To keep track of large amounts of data like hundreds, or even thousands, of customer names and
addresses, a database is needed such as Microsoft Access. To prepare tables of data and perform
numerical calculations, a spreadsheet is needed such as Microsoft Excel. In this text, you will
learn the basics of the Microsoft Excel 2000 spreadsheet application.

WORKSHEET BASICS

Microsoft Excel is a spreadsheet application developed to work in Windows. A spreadsheet is
similar to an accountant's columnar pad where you organize data in a grid-like structure and

perform calculations.

Excel is commonly used to prepare budgets, invoices, expense reports, employee payroll reports,
and any other documents requiring calculations. Excel also has many database features that you
can use to store and manipulate data.
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Figure 1.1: Acme Widget Company

The worksheet in Figure 1.1 displays individual monthly revenue amounts for Acme Widget
Company during the first quarter of the year. Labels (text) are used to identify each amount.
The amounts are known as values (numbers). The values and labels are keyed into the
worksheet, and then the totals are calculated. The totals are not actually numbers but formulas.
For example, the total for Sales is $33,300. This number is not typed in. Instead, a formula is
entered that adds the individual monthly amounts to give us the answer of $33,300. This way the
total is updated automatically when an individual number changes.
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LAUNCHING EXCEL

Start Excel

There are two primary ways to launch Excel. The most common way is to click Start,
Programs, Microsoft Excel from the Windows taskbar. You may also double-click the desktop
shortcut icon, if one exists, to start Excel. Figure 1.2 below illustrates using the Windows
taskbar to launch Excel.

Figure 1-2: Launching Excel from Windows Taskbar

THE EXCEL APPLICATION WINDOW

Workbooks and Worksheets

When you first start Excel, a new workbook is automatically created for you. A workbook is a
file consisting of multiple worksheets that you use to enter, view, and edit your data. By
default, there are three blank worksheets in each new workbook: Sheetl, Sheet2, and Sheet3 are
indicated by the sheet tabs at the bottom left of the worksheet window.

By default, you are given three worksheets in every new workbook. The actual number of
worksheets you can have in a workbook is limited by the amount of Random Access Memory
(RAM) on your computér. It is possible to have hundreds or even thousands of worksheets in
one workbook.

Application Window

The Excel application window is the main window that contains all of Excel's components.
Some of these components include the Worksheet Area, Title Bar, Menu bar, Standard and
Formatting toolbars, Formula bar, Scroll bars, and the Status bar.
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Figure 1.3: The Excel 2000 Application Window
Title Bar

The top bar in the window is the Title bar. The Title bar displays the application name and the
current workbook name as well as the standard application window control buttons such as
Close, Restore, Minimize, and Maximize.

Menu bar

The Menu bar is located below the Title bar and can be used to activate all of Excel's features
and commands by keyword. Use the mouse to click the keywords and select your choices from
the drop-down menu, or activate the drop-down menus by simultaneously pressing the Alt key
and the underlined letter in the command menu name. For instance, pressing the Alt key and the
F key simultaneously (Alt + F) will activate the File drop-down menu. Once the drop-down
menu is activated, you may use the arrow keys or the mouse to select a menu command. Run the
command by pressing the Enter key or double-clicking the menu item.

When you activate a menu from the Menu bar, you may not see the menu in its entirety due to
what is called the adaptive menu system. Only the menu options that you have recently used
are displayed. If you wish to display the entire drop-down menu, click the double arrows at the
bottom of the menu, or wait several seconds and the menu will expand on its own.

Standard Toolbar

The Standard toolbar is located directly below the Menu bar and contains a bank of buttons
that are used to perform many of Excel's common tasks. Save, Print, Spelling, Cut, Copy,
Paste, and AutoSum are examples of some of the buttons available on the Standard toolbar.
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Formatting Toolbar

The Formatting toolbar is below the Standard toolbar and consists of buttons that are used to
perform many of Excel's data formatting tasks. Boldfacing, italicizing, underlining, number
formatting, and changing fonts and font sizes are some examples of common tasks accomplished
using the Formatting toolbar.

Formula Bar

The Formula bar is located below the Formatting toolbar and consists of the Name box and
Entry area. The Name box displays your current position in the worksheet. The Entry area is
where you can see the data you are entering into your worksheet.

Worksheet Frame

The worksheet frame surrounds the top and left sides of the worksheet area. The worksheet
frame displays row heading numbers 1-65,536 and column heading letters A-IV. The Select All
button is the small gray button located at the intersection of the row and column headings on the
worksheet frame. Click this button to select all the cells on the worksheet at one time.

Worksheet Area

The worksheet area is made up of cells and is used to store all of your data. A cell is the
intersection of a column and a row and is used to hold one piece of information such as a word or
number. Each column is identified with a letter and each row, a number. There are 256
columns and 65,536 rows in one Excel worksheet. This makes for a total of 16,777,216
individual cells! , '

Cells .

Bach cell is referred to by its cell address, or cell reference. The cell address is the column letter
and row number in which a cell occupies. For example, the cell in column A and row 5 is
referred to as cell AS. The cell in column Z and row 5000 is referred to as cell Z5000.

When you wish to enter data into a cell, you must first make the cell active. Use the cell cursor
to select the cell. The cell cursor is a thick outline border that surrounds a single cell. Whatever
cell the cell cursor is sitting on is referred to as the active cell. The address of the active cell 1s
visible in the Name box on the Formula bar. To make a cell active, simply click the cell with
the mouse or use the arrow keys to navigate the cell cursor to the desired cell. Some keyboard
methods of relocating the cell cursor are shown in Table 1.1.

‘Cursor Movement - Keystroke -

Down one cell _ Down Arrow or Enter
Up one cell Up Arrow or Shift+Enter
Right one cell Right Arrow or Tab

Left one cell Left Arrow or Shift+Tab
Down one screen Page Down

Up one screen Page Up

Home cell (A1) Ctrl+Home

L ower right cell of worksheet | Ctrl+End

Table 1.1: Keyboard Navigation
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When you launch Excel and a new workbook opens, the active cell is cell A1 by default. Cell
Al is also referred to as the home cell. This is because it is the cell in the upper left corner of the
entire worksheet.

Status Bar

The Status bar is located at the bottom of the application window. The Mode indicator on the
lower right side of the Status bar indicates whether the Caps Lock (CAP), Num Lock (NUM),
or Scroll Lock (SCRL) are turned on. Ready also displays in the lower left corner of the Status
bar, and means that Excel is ready for you to enter data.

Scroll Bars 4

There are two scroll bars: one lying across the bottom of the worksheet area (horizontal scroll
bar), and the other running vertically along the right side (vertical scroll bar). The scroll bars
are used to move through a large worksheet. Clicking and dragging the scroll box on the scroll
bar cause the visible worksheet window to scroll left to right or up and down depending on
which scroll bar you are using. This feature comes in handy when navigating large worksheets
that expand beyond the visible window.

BEEEEEEER Launch Excel 2000, and Explore the Application Window |

I. Launch Excel.
a. Click Start, Programs, Microsoft Excel from the Windows taskbar.
II. Identify these major Excel worksheet elements:
Title bar
Menu bar
Standard and Formatting toolbars
Formula bar
Worksheet frame
Scroll bars
Worksheet area
Sheet tabs
I1I. Act1vate File menu using the mouse.
a. Click File on the Menu bar.
b. Click the double arrows at the bottom of the drop-down menu to display
the menu in its entirety.
c. Click the worksheet area to close the File menu.
IV. Activate File menu using the keyboard.
a. Press the Alt and F keys simultaneously (shortcut keys: Alt+F). Wait
several seconds and the File menu will display in its entirety.
b. Press the right arrow key several times to navigate across the Menu bar.
c. Choose the Tools menu, then press the down arrow to select features.
d. Press the Esc key twice to deactivate the Menu bar.
V. Relocate the cell cursor.
a. Place your mouse pointer on cell A5, and then click the left mouse button.
| i. Cell A5 is now the active cell.
\ ii. Note the cell address in the Name box.

T R ST
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b. Using the keyboard, press the up arrow key twice then right arrow key
three times.
c. Cell D3 is now the active cell.
d. Click cell H13.
i. Cell H13 is now the active cell.
e. Press Ctrl and Home keys simultaneously (shortcut keys: Ctrl+Home).
i. Cell A1, the home cell, is now the active cell.

VI. Minimize Excel.
a. Click the Minimize application control button on the Title bar. Minimize
i. Excel is minimized to an icon on the Windows Taskbar. button

VII. Maximize Excel.
a. Click the Excel icon on the Windows Taskbar.
" i. Excel is restored to its maximized view.
VIII. Exit Excel.
a. Click File, Exit from the Menu bar to exit Excel and return to the

Windows desktop.

b. You may also press Alt and F4 keys simultaneously (shortcut keys:
Alt+F4) to exit Excel.’ .

¢c. A third alternative would be to click the Close application control button Close
on the Title bar to exit Excel. button

ENTERING DATA AND WORKSHEET NAVIGATION

Before you enter data into an Excel worksheet, there are a few questions you should ask yourself
to help in the worksheet design process:

] What is the primary objective of the worksheet?
U What types of data will be used in the worksheet?

1 What types of calculations are needed?
(] Who will be looking at the worksheet?
O How will the worksheet be printed?

After you have answered the above questions, design your worksheet, and enter the data.

Entering Data into a Worksheet

The data you enter into worksheet cells is one of two types: text or values. The first key pressed
determines what type of data is being entered into the cell. If you start the cell entry with a digit,
decimal point, parenthesis, dollar sign, or equal sign, Excel will consider the entry a value.
Values actually fall under three categories: numbers, formulas, and functions. Formulas and
functions will be discussed later. If you start your cell entry with a letter such as P or W, then
the cell contents will be considered zext. If the data is mixed such as 445 Oak Street, then the
entry is still considered text. After you've entered data into a cell, you must hit the Enter key or
an arrow key to assign the data to the cell and overwrite the current contents.
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Data Alignment

When you enter text into a cell, it is left-aligned by default. When values are entered, théy are
right-aligned by default. The alignment of text or values may be changed after they are entered
into the cells.

Editing Cell Entries

If, after entering data, you wish to edit it, simply make the cell active and press the F2 key.
Pressing the F2 key, or double-clicking the cell, places the worksheet in Edit mode as displayed
by the mode indicator on the Status bar. Once in Edit mode, you can use the arrow keys or
mouse to select a portion of the data and edit. You then use your Backspace and Delete keys to
edit your cell entry. You may hit the Escape key at any time to back out of the cell and leave the
contents intact. After you finishing editing, press the Enter key to reassign the entry to the cell.

To delete data from cells, select the cell, and press the Deiete key.

Navigating the Worksheet
In the first exercise, you learned about the cell cursor, the active cell, and some simple methods
of relocating the cell cursor. Using the mouse and arrow keys are good methods of relocating the

cell cursor on the visible screen, but what if you want to go to a cell very far away, like cell
A500?

To relocate the cell cursor to a far away cell like cell
A500, use the Go To feature. To activate the Go To
dialog box, click Edit, Go To from the Menu bar or
press the FS key. A dialog box is a special window
that requests more information from the user before
the command can be executed. Many of Excel's
features require the use of a dialog box.

Once the Go To dialog box is activated, simply type
the cell address in the Reference field, and click
OK. Your cell cursor is then instantly relocated.

In addition to the Go To feature, you can also use
the Name box to relocate the cell cursor. Type the
cell address into the Name box, and then hit the
Figure 1.4: Go To Dialog Box Enter key. The cell cursor is then relocated.

Undo and Redo

Excel's Undo feature comes in handy when you make an error in your worksheet and wish to
reverse what you've done. To undo an action, either click Edit, Undo from the Menu bar, click
the Undo button on the Standard toolbar, or use the shortcut keys Ctrl+Z.

If you undo an action then decide that you did not need to undo after all, you can redo the action.
To redo an action, either click Edit, Redo from the Menu bar, click the Redo button on the
Standard toolbar, or use the shortcut keys Ctrl+Y.
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WORK WITH WORKBOOKS

Save a Workbook

Once your worksheet data have been entered, you should save your work for future use.
Frequently saving your work to disk ensures that in the event of catastrophe, such as power
failure, you can at least reopen your workbook from the disk where it was last saved. Saving
your workbook often is essential to keeping your information intact and up-to-date.

When saving a workbook for the
first time, you are required to use
the Save As dialog box. In this
dialog box, you specify the
workbook name and saving
location. To activate the Save As
dialog box, click File, Save As
from the Menu bar, or press the
F12 key. The Save button on the
Standard toolbar can also be
used. By default, Excel will save
the workbook with the name
Book1.xls to the C:\My
Documents folder on your : rosof A
computer's hard disk. ‘ Figure 1.5: Save As Dialog Box

Mlcr_nsoﬂjrﬁxcell Workd ook

A workbook file name can consist of up to 255 characters including spaces. Some characters
cannot be used such as asterisks, slashes, or question marks. Workbooks are usually named
according to what information they contain such as Six-Month Budget or Weekly Payroll
Report.

Print a Worksheet

Although your data is effective on screen,
sometimes you may wish to print a hard copy of P Lass 30t 2100 Sor (defau)
your information. Activate the Print dialog box
by clicking File, Print from the Menu bar or
by using shortcut keys Ctrl+P. When the Print
dialog box is open, you have many printing
options. To name just a few options, you can
specify how many copies to print, which printer
to print to (in a multi-printer environment), and
to print just certain sections of your worksheet.
The Print button on the Standard toolbar can
also be used; but be aware that when the Print
button is used, the worksheet prints in its
entirety without the benefit of the Print dialog box.

Figuré 1'.6: Print'Diélog Box
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Close a Workbook

Once you have saved, printed your data, and you are through working with the workbook, you
should close it. Closing the workbook removes it from the computer's memory. To close your

workbook, either click File, Close from the Menu bar, click the Close application control button
on the Title bar, or use shortcut keys Ctrl+F4.

Create a New Workbook

You can create a new blank workbook by clicking the New button on the Standard toolbar, by

clicking File, New from the Menu bar, or by using shortcut keys Ctrl+N.

Create, Save, Navigate, Print, and Close a Workbook

BC Company . __

xpense Report

xpense iJanuary February |March April May June

alaries | 5500/ 5500 5500 5500 5500 5500
{Rent | 2500 2500 2500 2500 2500 2500

elephone] 650 700 675 580 500 B25

rck 850 775 700 B0, 285 500
{Promotion; 2600 2280 3200; .-2300 2450 2200

2104 Mi : 1200: 1500 1750] 1450 1250 1100

I. Create a workbook.
a. Launch Excel.

b. Type your first name into cell A15.
c. Enter the numbers and labels exactly as shown.

d. After the data is entered, make cell A1 active by pressing the Ctrl+Hoine

keys simultaneously.
II. Save a workbook to the work disk.

a. Insert a disk into the floppy drive.
b. Click File, Save As on the Menu bar.

i. The Save As dialog box is activated.
c. Click the arrow in the Save in field and choose 3 1/2 Floppy (A:).
d. In the File name field, keyboard Ex 1-2 ABC Company Expense

Report.

e. Click Save button or press Enter key.

i. The workbook is saved to the work disk in your computer's floppy disk

drive.

ii. The workbook file narhe is now visible in the Title bar.

III. Relocate the cell cursor.

a. Click Edit, Go To on the Menu bar, or hit the F5 key.

i. The Go To dialog box is activated.
b. Keyboard F8 in the Reference field, and click OK or press Enter key.

i. Cell F8 is now active.

c¢. -Use the Go To dialog box again to make Cell C6000 the active cell.

d. Keyboard Al in the Name box on the Formula bar, and press Enter key.

10
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i. Cell A1, the home cell, is now active.
IV. Edit cell contents.
a. Select cell A2, and press the F2 key.
i. Cell A2 is active and in Edit mode.

b. Use Backspace, Delete and the arrow keys to edit the cell contents to read
Six-Month Expense Report.  After editing, press the Enter key to insert
the cell contents.

i. The cell A2 entry is now changed.

c. Select cell D7, and hit the Delete key.
1. The contents of cell D7 have been deleted.

d. Keyboard 700 into cell D7, and press Enter key.
i. Cell D7 displays the new value.

e. Delete the Promotion expense in May, and enter 2600 as the new amount.
i. Cell F9 displays the new value.

V. Undo and Redo actions.
a. Click the arrow next to the Undo button on the Standard toolbar, and
drag to select the last two actions from the drop-down list.
i. The last two actions are reversed.
b. Click the Redo button on the Standard toolbar twice.
i. The last two actions are reversed.
VI. Save a workbook.
a. Click the Save button on the Standard toolbar.
i. The workbook is automatically saved to the floppy drive.
VII. Print a worksheet.
a. Click File, Print on the Menu bar.
i. The Print dialog box is activated.
b. Keyboard 2 in the Number of Copies field.
c. Click OK.
i. Two copies of the current worksheet are sent to the printer.
VIII. Close a workbook.
a. Click File, Close on the Menu bar.
i. The workbook is now closed, but Excel remains active.
IX. Open a new workbook. D@
a. Click the New button on the Standard toolbar. New
i. A new, blank workbook is created. button
X. Exit Excel.
a. Click File, Exit from the Menu bar, or
b. Use the shortcut keys Ctrl+F4 to close the workbook.
i. Excel exits, returning you to the Windows desktop.

Redo
button

button

Open a Workbook

When you wish to use a previously saved workbook, you must open it. Opening a workbook
copies the file from the disk drive to the screen. To activate the Open dialog box, either click
File, Open on the Menu bar, click the Open button on the Standard toolbar, or use the
shortcut keys Ctrl+O. Once the Open dialog box is activated, click on the file icon or keyboard
the name in the File name field, and then click the Open button.

11
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Zoom
I_x My ocuments JEIK When working with a large
;‘;:*‘;ims | worksheet, it may be necessary to
"Iy Webs | reduce the size of the worksheet

_ | Offline
on the screen. By the same token,

users with visual impairments
may want to increase the size of
the worksheet on the screen.
Zoom settings may be
manipulated to accommodate
these desires. You change the
zoom setting by clicking View,
Zoom on the Menu bar or by
clicking the Zoom button on the
Standard toolbar. The zoom
settings range between 10% and 400%. Note that the zoom setting does not affect the
way the worksheet prints, only the way the worksheet appears on the screen.

Filé name:’ ‘I

5 Files of type: 'IAH Microsoft Excel Files

Figure 1.7: Open Dialog Box

Open a Workbook and Change the Zoom Setting

I. Launch Excel.
II. Open a workbook from the work disk.

é; a. Click the Open button on the Standard toolbar.
Open i. The Open dialog box is activated.
button b. Click the arrow in the Look in field, and choose 3 1/2 Floppy (A:).
i. The Ex 1-2 ABC Company Expense Report workbook name is
visible.

c. Click the Ex 1-2 ABC Company Expense Report workbook file name,
and then click the Open button.
. i. The ABC Company Expense Report workbook is open.
III. Adjust the zoom setting.

a. Click View, Zoom on the Menu bar.
i. The Zoom dialog box is activated.

b. Select the 75% option, and click OK.
i. The worksheet is 75% of normal size.

c. Click in the Zoom box on the Standard toolbar, and keyboard 85 %.
Zoom bo Press the Enter key.

i. The worksheet is 85% of normal size.
d. Click the arrow on the Zoom box to call up the drop-down list, and select
100% to bring the worksheet back to the default size.

= e. Practice adjusting the zoom setting using other percentages.
éave IV. Save a workbook to the work disk.
button a. Click File, Save As on the Menu bar.

i. The Save As dialog box is activated.
b. Click the arrow in the Save in field and choose 3 1/2 Floppy (A:).
c. In the File name field, keyboard Ex 1-3 ABC Company Expense
Report.

12
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d. Click Save button, or press Enter key.
i. The workbook is saved to the work disk in your computer's floppy disk
drive.
V. Close the workbook, and Exit Excel.

GETTING HELP WITH EXCEL

When working with Excel, it may be necessary to get assistance. Excel's help system has many
features to help you when you are in a jam.

Office Assistant :

The easiest method of getting help in Excel is to use the office assistant. The Office Assistant is
an animated character that provides answers based on what keywords you use in your question.
Activate the Office Assistant by clicking Help, Show Office Assistant on the Menu bar. When
the Office Assistant displays, type your question into the field, and click the Search button. The
Office Assistant then displays a bulleted list of likely help topics. After you use the Office
Assistant, click Help, Hide Office Assistant on the Menu bar to remove the Office Assistant
from the screen.

Contents, Answer Wizard, and Index

If the Office Assistant is not adequate to find help, you may use the main help system.
Contents, Index, and the Answer Wizard make up Excel's main help system. It is more formal
than the user-friendly Office Assistant and may be more helpful for advanced Excel features. To
use the Contents and Index help system, you first have to disable the Office Assistant since it is
the default help feature. Use the mouse to choose Help, Show Office Assistant from the Menu
bar, and click the Options button. When the Office Assistant dialog box appears, click to
remove the check mark in front of Use the Office Assistant. Click the OK button to adjust the
settings. Now with the Office Assistant turned off, click Help, Microsoft Excel Help on the
Menu bar to access the Contents, Index, and Answer Wizard.

What's This? Feature

The What's This? help feature is used to call up quick help for on-screen elements such as
toolbar buttons. When the What's This? feature is activated, your mouse pointer turns into a
mouse pointer with a thick, black question mark attached to it. When you click the unknown
screen element with the What's This? mouse pointer, a box appears with a brief description of
the element you clicked.

Exercise 1-4 Using Help Features J

1. Launch Excel.
II. Use the Office Assistant to locate a help topic.
a. Click Help, Show the Office Assistant on the Menu bar.
i. The Office Assistant is activated.
b. Double-click the office assistant to open the question field.

13
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L

Iv.

VL

c. Keyboard How do I save a workbook? in the question field, and click the
Search button.
d. When the search topics display, click the Save a Workbook option.
i. The Save a Workbook help window is activated.
e. Click the Save a New, Unnamed Workbook link.
i. The Save A New Unnamed Workbook help window is activated.
f. Read the contents of the help window.
g. Click the Print button on the help window toolbar, and then click OK in
the Print dialog box.
i. The help window's contents are sent to the printer.
h. Click the Close button in the upper right corner of the Help window.
i. The help screen closes, leaving the Office Assistant visible.
Deactivate the Office Assistant.
a. Right-click the Office Assistant.
i. A shortcut menu displays.
b. Click Options on the shortcut menu.
i. The Office Assistant dialog box is activated.
c¢. Remove the check mark from the Use the Office Assistant check box,
and click OK.
i. The Office Assistant is disabled.
Use the contents feature to locate a help topic.
a. Click Help, Microsoft Excel Help on the Menu bar.
i. The Microsoft Excel Help window is activated.
b. Click the Contents tab, if necessary, at the top left of the help window.
c. Click the + sign by the purple Editing Worksheet Data book.
i. The Editing Worksheet Data topic expands and displays subtopics.
d. Click the Edit Cell Contents topic and read.
Use the index feature to locate a help topic.
a. Click the Index tab on the left side of the Help window.
i. The Index window is activated.
b.. Type Margin in the Type keywords field, and then click the Search
button.
i. Set Page Margins should appear in the Choose a Topic window.
c. Read the Set Page Margins help topic.
Use the Answer Wizard to locate a help topic.
a. Click the Answer Wizard tab.
i. The Answer Wizard window is activated.
b. Keyboard How do I Print a workbook? in the What would you like to
do? field. Click the Search button.
c. Click the Print more than one copy of a workbook topic in the Select
Topic to Display window.
d. Read the help screen at the right of the help window.
e. Click the Close button in the upper right corner of the Help window.
i. The help window closes, and you return to the Excel worksheet.

VII. Use the What's This? feature to locate a help topic.

a. Click Help, What's This? on the Menu bar.

14



Chapter 1: Introduction to Excel 2000

i. The mouse pointer now has a thick question mark attached to it.
b. Click File, Print on the Menu bar.
i. A small help window is displayed on the Print command.
c. Click Help, What's This? on the Menu bar. Click the Save button on
the Standard toolbar, and read the tool tip.
d. Click other unfamiliar areas on the Excel worksheet using the What's
This? feature.
VIII. Exit Excel.

15
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CHAPTER SUMMARY

U Microsoft Excel 2000 is a spreadsheet application developed to work in a
Windows environment. Excel is used to create reports that require calculations.

U An Excel worksheet is a grid of columns and rows used to enter, organize, and
edit data.

U The intersection of a column and a row is called a cell.
[ Cells are used to store data.

(] The Excel application window consists of many components including the Title
Bar, Formula bar, Menu bar, Status bar, Scroll bars, Standard and
Formatting toolbars.

1 The two types of data that can be entered into a cell are text and values.
O Excel refers to files as workbooks.

1 Workbooks are saved as a file to your disk.

1 Workbook names can be 255 characters in length including spaces.

J A single workbook can have a virtually unlimited amount of worksheets.

{J The Undo feature reverses a previous action. Reversing an Undo action is called
Redo. '

U The Office Assistant, Contents and Index, Answer Wizard, and the What's
This? feature are your primary resources for help.

16
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CHAPTER 1 PROJECTS

- Project 1-1

Identifying Worksheet Components

Directions: Match the correct letter to the appropriate worksheet component.

Active cell:
Worksheet area:
Sheet tabs:
Name box:

Vertical Scroll bar:

Horizontal Scroll bar:

Title bar:

17

Formula bar:

Status bar:

Menu bar:
Standard toolbar:
Formatting toolbar:

Drawing toolbar:
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IL

IIL
Iv.

VL
VIL

IL.
1L
IV.

VI
VIL
VIIL
IX.

Project1-2

- Project1-3 .

Build, Save, and Print a Worksheet

il Petes Computer Store .
evenue and Expense Worksheet
evenue January _‘February ilarch Aprll ) ‘aMay o dune
ales 2244 1?30‘ 1243; 12627 16447 1365
ewvices | 2295 185? 2124[ ) 203? 1897 1486
;‘Dmdends _ 136:; o 1233 1542 1398 2367 2235
Xpenses Janu{ary February lvlarch _ Apnl May June .
tilities . 120[1' ©1208; 11380 1184 1213, 1171
ent 1200 1200 1200 12[]0 ~1200: 1200
alaries 850 BED 850" 8500 880 850
4 Promotion; 1161, 1155 1218, 1137 1132; 1135

Begin a new workbook, and build the worksheet as shown.

Save the workbook as Proj 1-2 Pete's Computer Store to the work disk in
your computer's floppy disk drive.

Edit cell A1 to read Pete's Computer Sales and Service.

Edit cell A2 to read Six-Month Expense and Revenue Report.

Zoom in to 95%, and resave the workbook.

Print a copy of the worksheet.

Close the workbook.

Open, Save, Edit, Print, and Save a Workbook

Open the Penney's Priceless Pets workbook from the data disk, and save it as
Proj 1-3 Penney's Priceless Pets to your work disk. :
Zoom in to 90%.

Edit cell A1 to read Penney's Priceless Pets.

Change the July phone bill to 250.

Change the September utilities bill to 300.

Undo your last two actions, and then Redo one action.

Edit cell A2 to read Expense Report.

Print the worksheet.

Make cell A1 active, and resave the workbook.

Close the workbook.

‘Project1-4 . Use Help

I. Open a new workbook.
II. Locate the following topics using the Office Assistant.
a. Save a workbook
b. Print a worksheet
c. Imsert a row
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d. Set a print area
III. Use the What's This? feature for the following tasks.
a. Click Data, Sort from the Menu bar.
b. Click an unfamiliar toolbar button.
c. Click the sheet tabs.
IV. Close the workbook.

Project 1-5 Build, Save, and Print a Worksheet

Harry’s Hardware Store
Product List ‘

tem #  {Cost {Price Difference |% of Difference
445 5.9 9.99 |
322, 499 7.99 . 1
233; 1299  18.99 |
124]  11.99.  15.99 2
566 9.99)  13.99 ‘
B55| 5.99i 8.98 |

i
TN

=

Open a new workbook, and build the worksheet as shown.
II. The Difference and % of Difference columns will be labeled but left blank
for now.
ITI. Save the workbook as Proj 1-5 Harry's Hardware Store to the work disk in
your computer's floppy disk drive.
IV. Print the worksheet.
V. Close the workbook.
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Practical Excel 2000

CHAPTER 1 CHALLENGE

Computer Operator

Please set up an Excel workeheet for our bowling league scores. Use the team name, The Fin Pals, a5
the worksheet title. Make sure your name is somewhere on the workeheet. Save the workeheet as
Challenge 1-1 Bowling Scores to your work digk and print a copy.

Thanks
The Boss

Game 1- Harris- 175, Smith-150, Jones-200
Game 2- Harris-2 15, Smith- 195, Jones-255
Game 3-Harris-200, Smith-254, Jones- 135
Game 4-Harris-235, Smith-250, Jones-110
Game 5-Harris-240, Smith-254, Jones-265
Game 6-Harris-200, Smith-250, Jones-275

By the way, do you think you could find and print the help screen on saving 2 workbook as a web page?
The home office wants us to be able to publish certain workbooks to the web in the future.

Tharks agaitll
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